IFRA-Nigeria Submission Guidelines
Part I
Publication principles
1. Authors whose texts have been accepted for publication by IFRA-Nigeria, either in book
form (printed and/or electronic) or as part of igeria Studies, IFRA-Nigeria’s peerreviewed journal, agree to transfer the associated rights permanently to IFRA-Nigeria.
They are free to re-publish these works or updated/edited versions of these works (in
printed or electronic form) subject to the following conditions:
• they provide a clearly visible reference to the original publication by IFRA-Nigeria
• they notify the management of IFRA-Nigeria and send them a copy of the new
publication.
2. Authors whose texts have been accepted release IFRA-Nigeria from any claim or action
by a third party (editors, authors, etc.) whose copyright has been infringed, whether
intentionally or not. Authors are responsible for the exactitude of references and
quotations.
3. The editorial committee of IFRA-Nigeria reserves the right to make editorial changes to
any text accepted for publication for the purposes of stylistic correction or clarification.
The authors will be consulted only in the case of modifications suggested by reviewers.
4. Text must be submitted in Microsoft Word 2003, 2007, or 2010 format (.doc or .docx) to
the following address: publish@ifra-nigeria.org

Presentation format
NOTE: All papers should follow a precise format of presentation. Papers deviating
significantly from these presentation guidelines will not be considered for publication and
will be returned to the author until the issues are fixed.

General
•
•

Use UK spelling, except in quotations from other texts.
The orthography of African words and names should conform to current best practice
in the Academia.

The Beginning of Your Paper
NOTE : Information identifying you will not be sent to reviewers.
In the article header, include the following information in the order shown.
•

•

Article title: Try to be as informative as possible in the title. Use of a sub-heading
after a colon can be helpful. For example:
The idea of civil society: A path to social reconstruction.
First name(s) and last name (in this order)
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•
•
•
•
•

•

Brief biographical note, approximately 50 words long, indicating your function and
field of expertise
Your affiliation (university, institute, department, organisation)
Your email address—and, if applicable, your personal or business online address
An Abstract of the article—maximum 200 words.
NOTE: An Abstract should contain the essence of the article and give the reader a
brief outline of its contents. Avoid a ‘thin Abstract’ that contains only a very general
guide to the subject of the paper. A reader should be able to determine from your
Abstract whether your article is worth reading or not. An Abstract may often be the
only thing a reader does read, so your Abstract is your opportunity to engage the
reader’s attention and persuade them to read further. If you have something important
to say or have discovered something interesting, be sure to let the reader know this in
the Abstract. An academic article is not a detective story where important information
is kept hidden from the reader until the last moment. Write your Abstract last. What is
your paper really about? What is the significance of what you have written about?
Why should anyone care? This information should be in the Abstract.
Five keywords, separated by commas

The Body of Your Paper
Headings and Paragraphs
1. The body of your article must include the following elements:
• Several sections marked by headings. Use the styles of MS Word (Heading 1,
Heading 2, etc.) as indicated below under the Styles: Fonts and Line Spacing section
in Part II of these guidelines.
• Simple paragraphs (style Normal by default).
2. The Introduction and the Conclusion must have a heading (‘Introduction’, ‘Conclusion’,
or other heading) and the heading must have the Heading 1 style.
Footnotes
• To insert a footnote, use the References menu in MS Word.
• Do not use the Endnote function in MS Word.
Tables and Figures
1. Do not include tables or figures in the paper without specifically referring to them in the
body text.
2. To insert tables, use the Table menu in MS Word.
3. Tables and figures must be numbered (Table 1, Figure 1, etc.) and accompanied by a title.
The title should
• Begin with an upper-case letter and end with a full stop.
• Be separated from the caption by an N-dash [see the last entry under the General
Typographic otes’ section in Part II below for an explanation of dash types].
• Not contain cross-references to a bibliographical reference or a page footnote.
4. Tables created using the Table menu in MS Word must be included in the main
document. The title of each table must be shown above it, as in this example:
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Table 1 – Here write the title of the table.
text text text
text text text

5. Very complex tables, containing special signs or particular formatting, should preferably
be treated in the same way as image-type files. They must be supplied by the author in the
form of a JPEG, GIF, or PNG file.
6. For figure images, please include in the main text the reference to the image file in the
following format.
Figure 1 - Here write the text of your figure title.
Here insert FIGURE 1 (file figure01.gif)
Graphics and Photographs
• Maps should, if possible, be of good quality (at least 300 dpi) and show all relevant
information—but only such information as is mentioned in the text.
• Photographs should specifically enhance the text and carry full captions and
attributions.
• All graphics must be clearly labelled in accordance with the main text, supplied in a
separate file, and of good quality (at least 300 dpi).
• Acceptable formats are JPEG, GIF, or PNG.

References Section
The References section should include only works, journals, websites, or software
applications mentioned in the body of the paper itself.
NOTE: A paper with an incorrectly formatted References’ section or a References’ section
containing a mix-and-match collection of formatting styles will be returned to the author and
will not be considered for publication until the issue is fixed.
Format of References
Al-Seghayer, K. (2001). ‘The effects of multimedia annotation modes on L2 vocabulary
acquisition: A comparative study’, Language Learning and Technology, 5(1), 202-32.
http://llt.msu.edu/vol5num1/alseghayer/default.html [Accessed 3 June 2010]
Conole, G. & Alevizou, P. (2010). A literature review of the use of Web 2.0 tools in Higher
Education. Report commissioned by the Higher Education Academy.
http://www.heacademy.ac.uk/assets/EvidenceNet/Conole_Alevizou_2010.pdf [Accessed 3
June 2006]
Hulstijn, J. H. (1992). ‘Retention of inferred and given word meanings: Experiments in
incidental vocabulary learning’. In: Arnaud, P. J. L. & Béjoint, H. (eds). Vocabulary and
applied linguistics. London: Macmillan. 113-25.
Kaplan, A. M., & Haenlein, M. (2010). ‘Users of the world, unite! The challenges and
opportunities of social media’, Business Horizons, 53, 59-68.
Levelt, W. J. M. (1989). Speaking: From intention to articulation. Cambridge, MA: MIT
Press.
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XXX, G. W. (2010). ‘The importance of social media’, Journal of Whatever, 5(2), 41-63.
Available online: http://www.journalofblabla.org [Accessed 4 May 2009]
Format of Software References
Tatiana (2008). Trace Analysis Tool for Interaction ANAlysts. http://lead.emse.fr
Interviews
First reference: Interview with Bakari Kamian, Bamako, 11 July 2002
Subsequent references: Interview with Bakari Kamian

Part II
NOTE: Papers deviating significantly from these presentation guidelines will not be
considered for publication and will be returned to the author until the issues are fixed.

MS Word Matters
•
•

Do not paginate your text or add page headers or footers.
Always spell-check your text as a last step before submission.

Styles: Fonts and Line Spacing
Use Times New Roman font. The font sizes (styles) must be as follows.
•
•
•
•
•

Heading 1: Times New Roman 18
Heading 2: Times New Roman 16
Heading 3: Times New Roman 14
Footnotes: Times New Roman 10
Normal: Times New Roman 12

The simplest and best way to format with these styles is to use the Style menu in MS Word
and apply it systematically. In case of difficulty, check the Help in MS Word.
•
•
•

Use line spacing of 1.5 and justify body text.
To introduce a new paragraph in your text, use a single line-break only. The vertical
spacing of paragraphs will be organised by the editorial team.
Never use the Tab key to format your text.

Highlighting and Typographic Styles
To make reading easier, limit the number of highlights using typographic styles and remain
consistent in the use of the chosen style. Too many highlights produce an amateurish and
confusing impression on the reader. It is far better to make your point by writing well than by
resorting to typographic gimmicks.
Please adhere to the following guidelines:
•
•

Do not use bold.
Italics should be used only for the names of publications (titles of journals, books,
newspapers, magazines) and for words in languages other than English. Foreign
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•
•
•

words should be used only when necessary, and then only with a translation in
parentheses.
If a quotation contains italics, please indicate whether it is in the original or was added
by you: [emphasis in original] or [emphasis mine].
Do not underline.
Do not write a group of words or a sentence in upper-case letters.

Table of Contents
• Book-length texts can have an updateable Table of Contents inserted automatically by
MS Word if one applies Word’s Style menu consistently. You do not then need to
waste time creating a Table of Contents manually or adding page numbers to it.
Table Headings
• MS Word allows one to insert the first row (with the headings of the columns) of a
table in such a way that when the table runs over one page, the column-heading row is
automatically reproduced on the second page (and subsequent pages, if any). Please
apply this as a default.

General Typographic and Style Guidelines
•
•

•
•
•

•
•

•

•
•

Full stops (periods) should be followed by a single space.
Use the Oxford/Harvard comma: If you list 3 or more items in a series, the Oxford
comma is the convention of placing a comma + and before the last item, rather than
and only: A, B, and C—rather than A, B and C. It is required by Oxford University
Press—hence the name—and also standard in most academic journals.
Dates should be in the form 6 June 2000 [no commas].
Quotations and references in the body of the text.
All references in the body of the article must be referenced with an indication of the
page number (if possible) and included in the References section at the end of the
article. Note that the page numbers are not preceded by the abbreviation p. or pp. but
by a colon. For example: As Smith (1990: 347) observed, “the incidence of this and
that . . .”
Single quotation marks [‘this is an example’] are used to distinguish words, concepts,
or short phrases under discussion. They can also be used to indicate sarcasm.
Double quotation marks [As Smith (1990: 45) noted,“[t]he increased incidence of
ABC in igeria . . .”] are used for short quotations (less than two lines) included in
the body of the text.
Long quotations (more than two lines) are put in a separate paragraph. The text is
shown without quotation marks and includes a reference in brackets at the end and
after the punctuation. For example:
Our avowed zero-tolerance for the scourge of corruption derives from our
conviction that countering corruption and promoting public integrity are
critical to economic rebirth and sustained development … The globalized
world in which we live today has become hostile to corrupt nations and their
citizens. (The Punch, 6 September 2005)
Well-known abbreviations are written without full-stops (USA, NATO, EU).
Abbreviations of Christian names use full-stops and spaces: G. B. . Shaw.
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•
•

•

•

•
•

•
•
•
•
•
•

•
•
•

All references in a text to other parts of the text should be uppercase. For example: As
discussed in Chapter 4 and Chapter 9 above …
All references to tables and figures in the main text of the paper should be upper-case:
Table 1, Figure 1. It is usually quite sufficient to state facts about a table or figure in
the main text and just include (Table 1) or (Figure 1) at the end of the sentence. The
reader is intelligent and you do not have to specifically instruct him/her to see Table
1. For example, this is quite sufficient: The population of ABC rose by 50 per cent
between 1999 and 2010 (Table 1).
cf. The abbreviation cf. (‘confer’, ‘compare’) is used to signal that one item is to be
compared with another elsewhere (cf. Phipps, 34-40). Do not confuse cf. with ‘see’. If
your text contains very many cf. references, you are likely to be making this mistake.
etc. Try to avoid the use of etc. when possible. It forces the reader to guess. Do not
end a list with etc. if it begins with including, for example, or such as, since these
already indicate that the list will be incomplete.
e.g. and i.e. should not be used in formal texts. Use for example and that is
ibid. (short for ibidem) means ‘in the same place’. Its abbreviation is ibid. [note the
full stop] in body text, and uppercase Ibid. if at the beginning of a footnote. It is used
in place of the author's name and the title of the source when this would otherwise
duplicate the citation in the immediately preceding note. A comma is unnecessary if a
volume and/or page number follows; however, if any other matter follows, a comma
is required:
Stratford, Apple Crumble, 21
Ibid. 28
Ibid.
Smith, Cherry Cake, ii. 23
Ibid. i. 45
Ibid., App. A.
Loc. cit. and op. cit. should not be used.
Square brackets [ ] in a quotation indicate any additions/changes which are not in the
source text.
For centuries in history, please use full words and lower-case: nineteenth century.
Use BCE and CE, not BC and AD.
The 1990s [no apostrophe].
Numbers should be elided as 157–63, 208–9, but 11–13. Spell out numbers up to ten
and multiples of ten up to one hundred (seven, twenty, but 25, 127, 10,000). Where
there is a mixture of numbers normally written in words and figures, give all numbers
in figures to avoid unpleasant effects: There were, respectively, 4, 9, 20, and 25
attendees at the first four meetings. Figures should be used for units of measurement,
for percentages (to be shown in the form 7 per cent, not 7%), and for any number that
includes a decimal point.
No numbers at the beginning of a sentence. Write out the number in full or, better yet
if the number is large, rearrange the sentence to avoid the number coming first.
Commas to indicate thousands and millions (1,500,000 and 1,400); dots to indicate
decimal points (98.5 per cent)
Hyphens, N-dashes, M-dashes. There are 3 horizontal lines in English typography:
hyphen, N-dash, and M-dash (the last 2 are also referred to as en and em dashes),
1. Hyphen (-) is on the keyboard
2. N-dash (–) is correctly used to indicate ranges. For example: 1989–99, 1874–
1910 This line is longer than a hyphen and was originally the width of the
6

letter n in the font used by typesetters—hence the name. MS Word
automatically creates this (on a pc) if one types:
word1+space+hyphen+hyphen+space+word2
When one exits word2, MS Word will change the 2 hyphens into an N-dash.
You then need to close up the spaces manually to get, for example, 1985–89.
3. M-dash (—) is longer again than the N-dash and was originally the width of
the letter m in the font used by typesetters. There is no space between the line
and the words on either side. For example: come—go. MS Word
automatically creates this (on a pc) if one types, without spaces:
word1+hyphen+hyphen+word2
When one exits word2, MS Word transforms the 2 hyphens into an M-dash,
connecting the words directly. This M-dash is what is commonly considered ‘a
dash’.

7

